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Thank you for purchasing these FUJIFILM products.
This “Software Quick Start Guide” describes how to connect the camera to the
USB port on your PC and how to install the enclosed software on your PC. It
also provides a quick guide to using the software and a section on
troubleshooting any problems that may arise. Read this manual carefully to
ensure that you make the best possible use of the software.
The functions described in this guide are available on FinePixViewer Ver.1.1
or later. However, some functions are not available on FinePixViewer Ver.1.0.
For detailed information on using FinePixViewer and DP Editor, refer to the
User’s Guide (PDF).

E

� USB Mass Storage Driver
� USB PC Camera Driver
� FinePixViewer
� DP Editor
� Exif Launcher

Software Quick Start Guide

Please read this guide carefully before using this software with a PC.
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IMPORTANT
Be sure to read this page before using the Software.

Please note that this Guide is written on the assumption that you already have a basic
understanding of how to use your PC (personal computer), Windows and Macintosh.
For basic information on using your PC, Windows and Macintosh, refer to the respective
manuals supplied with your PC.

• Microsoft and Windows are trademarks of the Microsoft Corporation of the U.S. registered in
the U.S. and other countries.
Windows is an abbreviated term referring to the Microsoft Windows Operating System.

• Macintosh, iMac, Mac OS and QuickTime™ are registered trademarks of Apple Computer,
Inc.

• Adobe Acrobat® Reader™, ActiveShare™ and PhotoDeluxe are trademarks of Adobe
Systems Incorporated of the U.S.

• VideoImpression™ is a registered trademark of ArcSoft Inc.
• SmartMedia™ is a trademark of Toshiba Corporation.
• All other company or product names are trademarks or registered trademarks of the

respective companies.

a
Do not attempt to play the CD-ROM enclosed with this product on
an audio CD player.
Doing so could damage your hearing or could damage your
speakers or headphones.

This End User License Agreement (“Agreement”) is an agreement between Fuji Photo Film Co., Ltd.
(“Fuji”) and you, which sets forth the terms and conditions of the license granted for you to use the
software provided by Fuji.
The CD-ROM contains third party software. In case a separate agreement is provided by a third
party supplier for its software, the provisions of such separate agreement shall apply to the use of
such third party software, prevailing over those of this Agreement.

1. Definitions.
(a) “Media” means the CD-ROM titled “Software for FinePix EX” which is provided to you together with

this Agreement.
(b) “Software” means the software which is recorded on Media.
(c) “Documentation” means the operation manuals of Software and other related written materials which

are provided to you together with Media.
(d) “Product” means Media (including Software) and Documentation collectively.

2. Use of Software.
Fuji grants to you a nontransferable, nonexclusive license:
(a) to install one copy of Software onto one computer in binary machine executable form;
(b) to use Software on the computer onto which Software is installed; and
(c) to make one backup copy of Software.

3. Restrictions.
3.1 You shall not distribute, rent, lease or otherwise transfer all or any part of Software, Media or

Documentation to any third party without Fuji’s prior written consent. You also shall not sublicense,
assign or otherwise transfer all or any part of the rights granted to you by Fuji under this Agreement
without Fuji’s prior written consent.

3.2 Except as expressly granted by Fuji hereunder, you shall not copy or reproduce all or any part of
Software or Documentation.

3.3 You shall not modify, adapt or translate Software or Documentation. You also shall not alter or
remove copyright and other proprietary notices that appear on or in Software or Documentation.

3.4 You shall not, or shall not have any third party, reverse-engineer, decompile, or disassemble
Software.

4. Ownership.
All copyrights and other proprietary rights to Software and Documentation are owned and retained by
Fuji or the third party suppliers as indicated on or in Software or Documentation. Nothing contained
herein shall be construed, expressly or implicitly, as transferring or granting any right, license, or title to
you other than those explicitly granted under this Agreement.

5. Limited Warranty.
Fuji warrants to you that Media is free from any defect in material and workmanship under normal use for
ninety (90) days from the date of your receipt of Media. Should Media not meet the foregoing warranty,
Fuji shall replace such defective Media with other Media bearing no defect. Fuji’s entire liability and your
sole and exclusive remedy with regard to any defect in Media shall be expressly limited to such Fuji’s
replacement of Media as provided herein.

NOTICE
BEFORE OPENING THE PACKAGE OF CD-ROM PROVIDED BY FUJI PHOTO FILM CO., LTD.,
PLEASE READ THIS END USER LICENSE AGREEMENT CAREFULLY. ONLY IF YOU DO
AGREE TO THIS AGREEMENT, YOU WILL BE ABLE TO USE THE SOFTWARE RECORDED
ON THE CD-ROM. BY OPENING THE PACKAGE, YOU ACCEPT AND AGREE TO BE BOUND
BY THIS AGREEMENT.

End User License Agreement

6. DISCLAIMER OF WARRANTY.
EXCEPT AS PROVIDED IN SECTION 5 HEREIN, FUJI PROVIDES PRODUCT “AS IS” AND
WITHOUT WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED. FUJI SHALL MAKE NO
WARRANTY, EXPRESS, IMPLIED OR STATUTORY, AS TO ANY OTHER MATTERS, INCLUDING,
BUT NOT LIMITED TO NON-INFRINGEMENT OF ANY COPYRIGHT, PATENT, TRADE SECRET, OR
ANY OTHER PROPRIETARY RIGHTS OF ANY THIRD PARTY, MARCHANTABILITY, OR FITNESS
FOR ANY PARTICULAR PURPOSE.

7. LIMITATION OF LIABILITY.
IN NO EVENT SHALL FUJI HAVE ANY LIABILITY FOR ANY GENERAL, SPECIAL, DIRECT,
INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR OTHER DAMAGES (INCLUDING DAMAGES FOR
LOSS OF PROFITS OR LOST SAVINGS) INCURRED FROM THE USE OF OR INABILITY TO USE
PRODUCT EVEN IF FUJI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

8. No export.
You acknowledge that neither Software nor any part thereof, will be transferred, or exported to any
country or used in any manner in violation of any export control laws and regulations to which Software is
subject.

9. Termination.
In case you breach any of the terms and conditions hereof, Fuji may immediately terminate this
Agreement without any notice.

10.Term.
This Agreement is effective until the date when you cease to use Software, unless earlier terminated in
accordance with Section 9 hereof.

11.Obligation upon termination.
Upon termination or expiration of this Agreement, you shall, at your own responsibility and expense,
delete or destroy immediately all Software (including its copies), Media and Documentation.

12.Governing Law.
This Agreement shall be governed by and construed in accordance with laws of Japan.
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Introduction
Glossary of Terms

This section provides explanations of the minimum basic operations you must
be familiar with in order to use your personal computer, along with an
introduction to some other operations that will help you to use your computer
more efficiently. For more detailed information on using your computer, refer
to the user manuals supplied with the computer.

� Application software
Software used for a specific purpose, such as word processing, spreadsheets or image
editing.

� Browser
Software used for viewing web pages on the Internet. Examples include Internet
Explorer and Netscape Navigator.

� Click, Double-click
Click: Pressing the left mouse button (Windows) or the mouse button (Macintosh) once

and then releasing it.
� Used to select files, folders, windows, buttons, etc.

Double-click: Clicking the left mouse button (Windows) or the mouse button (Macintosh)
twice.

� Used to open files, folders, etc.

� DPOF
A format used for recording information on SmartMedia that specifies which images are
to be printed.

� Drag & drop
An operation used to move, copy or store files and folders.

Left

Double-
click Click

Windows Macintosh

� Drive
A peripheral device used by a personal computer to store and access files.
A disk drive into which removable media can be loaded is referred to as a removable
disk drive.
Typical examples include CD-ROM drives and floppy disk drives. Digital cameras are
also handled as disk drives.

Drive icons in Windows Drive icons for Macintosh

� Driver
Software used by a personal computer to operate a peripheral device.

� Folder
A location in which related files are stored. Other folders can also be stored inside a folder.

� Install
The process of setting up software on a personal computer.

� Menu
A list of functions displayed at the edge of the screen. Typical examples include the
“File” and “Edit” menus.
When you click on a menu name, a list of the available functions appears and you can
then execute a function by moving the mouse to the desired function name.

<Windows> <Macintosh>

� Server
A computer used on a computer network, such as the Internet, that provides services
and data to connected network users.

� Thumbnail
A reduced image created when images are displayed as a list. In FinePixViewer,
double-clicking on a thumbnail image displays the original image.

� Uninstall
The process of removing software from your PC and restoring your PC’s settings to
their original status before the software was installed.

Specifications for the 
images to be printed 
(trimming data, etc.)SmartMedia

Images

Drag
1. Position the mouse pointer over the

file or folder icon you want to drag.
2. With the mouse button held down,

move the mouse to another location.

Drop
When you reach the desired location,
release the mouse button.
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FinePixViewer

QuickTime

DP Editor

Acrobat  Reader

FinePix Internet Service

Exif Launcher

VideoImpression
Launches the FinePixViewer 
software when a camera is 
connected.

Allows you to display thumbnail lists of 
the images stored on your PC or in the 
camera, print the images individually or 
as an index, display the images at full 
size and perform some basic image 
processing.

Software needed for 
playing back movies, etc.

You can use this software to generate the 
information you will need to print your images 
using a printer that supports DPOF (Digital Print 
Order Format).

Software used to read PDF-format documents on a 
personal computer. This software is needed to read the 
User’s Guides for FinePixViewer and VideoImpression.

TM

TM

R

Users can sign up to get access 
to a wide range of services.

To sign on as a user, refer to the 
following pages:
Windows users   : P.35
Macintosh users : P.73

Used to download and edit 
movies you have shot.

FinePixViewer

TM

PictureHello

PC Camera Driver

PictureHello

Mass Storage Driver

<About the Software>

Digital camera

If the camera’s USB 
setting is “DSC”.

*

If the camera’s USB 
setting is “PC Camera”.

USB connection

Allows a digital camera to be used as 
USB Mass Storage (removable disk 
drive).

Allows a digital camera to be used 
as a PC Camera. Some cameras 
do not support this function.

Requirements
 • A FUJIFILM camera that has the PC Camera function.
 • A connection to the Internet
 • A Windows PC with a sound card and a microphone

and speakers connected

Used for videoconferencing 
(Windows only)

Transmission:
Via the Internet

Taking Part in a Videoconference

Personal 
computer

Depending on the particular camera model 
you purchased, what you actually see may 
differ from the illustrations shown here.

USB connection
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Pre-installation Checklist

Installation on a Windows PC

� Hardware and software requirements
To run this software, you must have the hardware and software described
below. Check your system before you begin the installation.

Compatible PCs : IBM PC/AT or compatible✽1

Operating System : Windows 98 (including the second edition)
Windows Millennium Edition (Windows Me)
Windows 2000 Professional
(For installation, log in using the Administrator group.)

CPU : Pentium 200 MHz or better
RAM : 64 MB minimum
Hard disk space : Amount required for installation: 140 MB minimum

Amount required for operation: 300 MB minimum
Display : 800 × 600 pixels or better, 16-bit color or better
Supported cameras : Fujifilm digital cameras equipped with a USB interface
Internet connection✽2 : 56 kbps modem connection (recommended) or better

or an ISDN connection
Sound functions✽3 : Speakers, microphone and sound card

✽1 Models with a USB interface as a standard feature and one of the above
operating systems preinstalled.

✽2 Required to use the FinePix Internet Service and videoconferencing. The
software can still be installed even if you do not have an Internet connection.

✽3 Cameras that feature the “PC Camera” option in the USB settings allow you to
use the videoconferencing functions and the VideoImpression capture function.
Sound functions are required for audio input/output in VideoImpression and
videoconferencing.

• Connect the camera/cradle directly to the computer using the special USB
cable. The software may not operate correctly if you use an extension cable or
connect the camera/cradle via a USB hub.

• If your computer has more than one USB port, the camera can be connected to
either port.

• Push the USB connector fully into the socket to ensure that it is securely
connected. The software may not operate correctly if the connection is faulty.

• Additional USB interface board is not guaranteed.
• Windows 95 cannot be used.
• Operation is not guaranteed on home-built computers or on computers running

updated operating system software.
• Use the drivers (the Mass Storage Driver and PC Camera Driver) provided on

the enclosed CD-ROM. When older drivers are already installed on your PC,
uninstall the old versions and then re-install the drivers provided on the
enclosed CD-ROM.

• If your Internet connection is via a router or via a LAN (connecting machines on
the LAN to the Internet), you cannot use videoconferencing.

NOTE

Installing the Software
� The following applications are installed by the Installer:

FinePixViewer
DP Editor
Exif Launcher
QuickTime™
NetMeeting 3.01 (Windows 98 computers must upgrade to this version.)
VideoImpression™
Windows Media Player
Acrobat® Reader™
ActiveShare™
PhotoDeluxe

Have the Owner’s Manual for your camera handy and read it
in conjunction with these instructions.

1. Switch on your PC and start up Windows.

2. Quit all other active applications until no applications are
shown in the taskbar.

1 Click the right mouse button on the application icon in the taskbar.
2 Click “Close” in the menu that appears to quit the application.
✽ Refer to the instructions provided with your PC and applications (antivirus

software, etc.) for details.

3. If the following applications are installed on your PC, use
“Add/Remove Programs” in the Control Panel to uninstall the
applications. (See P.50.)
� Exif Viewer
� Exif Launcher (Uninstallation cannot proceed unless you

shut down all resident programs.)
� DP Editor

4. Load the enclosed CD-ROM into the CD-ROM drive. The
installer starts up automatically.
✽ If the installer does not start up automatically, see “Launching the Installer

Manually” on the next page.

Installation Preparations

<Taskbar>

Applications to be shut down
(the icons shown vary depending on
the applications that are running)
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1. The Setup screen appears.
Click the [Install FinePixViewer] button.

2. A list of the applications to be installed appears. Check the
list and then click the [OK] button.

3. Use the procedure given below to install each of the listed
applications. When installation of an application is
completed, installation of the next application begins
automatically.
1 Check the notes and warnings.

Notes and warnings are displayed
relating to the applications being
installed. Check the details and then
click the [Next >] button.

Starting the InstallationLaunching the Installer Manually

1. Double-click the “My Computer” icon.

2. Double-click “PHOTODELUXE (D:)” in the “My Computer”
windows.

✽ (Here, “D:” is the designation for the
CD-ROM drive.)

3. Double-click “Setup” or “Setup.exe” in the CD-ROM
window.

✽ The way file names are displayed differs as described below depending on your
computer settings.
• File extensions (3-letter suffixes indicating the file type) may be shown or

hidden.
• Text may be shown normally or all in uppercase (e.g. Setup or SETUP).

• When the “User Registration” window opens during installation, you can complete
the installation without entering any data.

• If the “Connection speed” window appears, set the correct speed for your type of
connection and proceed with the installation.

Notes on Installing QuickTime
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2 Select the installation destination.
An installation destination window is
displayed. You can change the
installation destination by clicking
the [Browse…] button. Check the
destination and then click the 
[Next >] button.

3 Installation
The installation (copying files, changing settings, etc.) begins automatically.

4 Complete the installation.
When installation ends, a
confirmation window appears. Click
the [OK] button to proceed to the
next installation. (This procedure
begins again automatically from
step 1.)

4. Finally, the restart window appears. Click the [Restart] button.
✽ FinePixViewer installation is not completed until you restart your computer.

5. After you restart your computer, follow the procedure on P.12
to start up the Installer manually. 
Use the same procedure to install “Acrobat Reader”.
✽ To read the FinePixViewer User’s Guide (PDF), you must have Acrobat Reader

from Adobe Systems, Inc. installed.
✽ Acrobat Reader installation does not require a restart.

6. Use the same procedure to install “PhotoDeluxe” and
“ActiveShare”.
✽ When you have finished installing “ActiveShare”, you may be asked to restart

your computer. In this case, begin installing “PhotoDeluxe” without restarting
your computer.

If a “----.dll file not found.” message appears during installation, there is another
application running in the background (a screen saver or similar application that
could not be shut down in step 1). Forcibly shut down the application. Refer to your
Windows manuals for information on how to forcibly shut down an application.

NOTE

The User’s Guide (PDF) and How to Read It
To read the FinePixViewer User’s Guide (PDF), you must have Adobe
Systems’ Acrobat Reader installed on your computer. See P.14 for
information on installing Acrobat Reader.

� Reading the User’s Guide

1. Select “Start” / “Programs” / “FinePixViewer” and click
“English.pdf”.
� Acrobat Reader starts up and displays the User’s Guide.

2. To jump to the relevant page, click the desired topic listed in
the Contents or Bookmarks.
✽ To view the bookmarks, click “Show Bookmarks” in the Window menu. 

For more information on how to use Acrobat Reader, refer to the Online Guide in
the Acrobat Reader Help menu.

� Printing the User’s Guide

1. Click “Page Setup” in the File menu and specify the required
settings (“Paper”, “Layout”, etc.).
� If you print the manual at the original dimensions, each page fits on one sheet of

A4 paper in Portrait layout.

2. Click the [Print] button or select “Print” in the File menu.

3. Specify the range of pages to be printed and the number of
copies, etc. and then click the [OK] button.

• The available options vary depending on your printer and printer driver
software. Refer to your printer driver manual for details.

• For more information, refer to the Online Guide in the Acrobat Reader Help
menu.

NOTE
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If you are asked for a disk labeled “FINEPIX” during installation, refer to
“Troubleshooting” (See P.54).

7. The “Add New Hardware Wizard” dialog appears. 
Click the [Next >] button.

If the dialog box does not appear,
uninstall and then re-install the Mass
Storage Driver. (See P.16, 49.)

8. Select “Search for the best driver for your device
(Recommended)” and click the [Next >] button.

9. When the next window opens, tick the “CD-ROM drive”
checkbox and then click the [Next >] button.
✽ If any checkboxes other than “CD-

ROM drive” are ticked, clear the
ticks so that “CD-ROM drive” is the
only checkbox ticked.

✽ The dialog shown may differ slightly on some types of PC.

NOTE

Windows 98/98SEInstalling the Mass Storage Driver
Installing Mass Storage Driver allows you to transfer files recorded on the
camera to your PC.

The Windows CD-ROM may also be required in some cases. Have the CD-ROM
ready beforehand.

1. Switch on your PC and start up Windows.

2. Double-click the “My Computer” icon.
✽ When installation is completed, a

new removable disk icon (the
connected camera) [ ] is added.

3. Insert the enclosed CD-ROM into the CD-ROM drive.
If the installation screen for the applications provided on the
CD-ROM appears, click the [Exit] button to exit the screen.

4. Select the camera settings.
If your camera has “DSC (Mass Storage)” and “PC Camera” functions in the USB setting 
(such as FinePix6800 ZOOM)

Load a SmartMedia containing images you have shot into the
camera. Select “DSC” in the camera’s USB setting.

If your camera has only the “DSC (Mass Storage)” function in the USB setting

Load a SmartMedia containing images you have shot into the
camera.

• Refer to “PC Connection” in the Owner’s Manual for your camera for more
information on camera operation and the USB setting.

• Use only SmartMedia containing images shot on a FUJIFILM digital camera.
• It is strongly recommended that you connect the AC power adapter when you are

using a USB connection to avoid loss of power while you are using the camera.

5. Using the enclosed USB cable, connect the camera (or the
cradle) to the USB port on your computer and then switch the
camera on.

6. A message appears in the “New Hardware” dialog box
indicating that “USB Mass Storage” has been detected.
✽ See P.19, if you are using Windows Millennium Edition.
✽ See P.20, if you are using Windows 2000 Professional.

NOTE

NOTE
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7. The “Add New Hardware
Wizard” dialog opens. Click
the [Next >] button.

• It may take a few minutes for the
dialog box shown at right to appear
after USB Mass Storage is detected.

• If the dialog box does not appear,
uninstall and then re-install the Mass
Storage Driver. (See P.16, 49.)

8. Select “USB Mass Storage”
on the same line as
“\USBDRV\WINME\UFLT04C
B.INF” on the CD-ROM and
then click the [OK] button.

The Windows Me CD-ROM may also be
required during installation. In this
event, switch CD-ROMs as directed by
the on-screen instructions.

9. When you click the [Finish]
button, the “New Hardware”
dialog box appears. Wait
until the dialog box
disappears.

10. Installation is completed
when a new removable drive
icon (the connected camera)
[ ] appears in the “My
Computer” window.

NOTE

NOTE

Windows Millennium Edition (Windows Me)10. Check that USBS04CB.INF
has been detected and then
click the [Next >] button.

The Windows 98 CD-ROM may also be
required during installation. In this
event, switch CD-ROMs as directed by
the on-screen instructions.

11. When the window shown at
right appears, click the
[Finish] button.

12. Installation is completed
when a new removable drive
icon (the connected camera)
[ ] appears in the “My
Computer” window.

NOTE

1 First uninstall Mass Storage Driver. (See P.49.)
2 Re-install Mass Storage Driver. (See P.16.)

When [ ] does not appear
1 First uninstall Mass Storage Driver. (See P.49.)
2 Re-install Mass Storage Driver. (See P.16.)

When [ ] does not appear

Click here.

Check the file name.
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10. Check that USBS04CB.INF
has been detected and then
click the [Next >] button.

11. When driver installation is
completed, the screen
shown at right appears.
Click the [Finish] button.

12. Installation is completed
when a new removable drive
icon (the connected camera)
[ ] appears in the “My
Computer” window.

7. The “Found New Hardware
Wizard” dialog opens. Click
the [Next >] button.

If the dialog box does not appear,
uninstall and then re-install the Mass
Storage Driver. (See P.16, 49.)

8. Select “Search for a suitable
driver for my device
(recommended)” and then
click the [Next >] button.

9. In “Optional search locations”, tick the “CD-ROM drives”
checkbox and then click the [Next >] button.
✽ If any checkboxes other than “CD-

ROM drives” are ticked, clear the
ticks so that “CD-ROM drives” is the
only checkbox ticked.

✽ The screen shown may differ slightly depending on the type of computer.

NOTE

Windows 2000 Professional

1 First uninstall Mass Storage Driver. (See P.49.)
2 Re-install Mass Storage Driver. (See P.16.)

When [ ] does not appear
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Installing the PC Camera Driver
If your camera has a “PC Camera” function in the USB setting, installing PC
Camera Driver allows you to import live images from the camera.
✽ Use PictureHello (see P.38) or VideoImpression (see P.45) to actually view live

images.
✽ Here, “live images” refers to the video images shown on the LCD monitor when the

camera is set to photography mode.
✽ If you use a camera that does not have the “PC Camera” function in the USB settings,

live images cannot be transmitted.

The Windows CD-ROM may also be required in some cases. Have the CD-ROM
ready beforehand.

1. Switch on your PC and start up Windows.
✽ Do not connect other video capture equipment to your PC.

2. Insert the enclosed CD-ROM into the CD-ROM drive.
If the installation screen for the applications provided on the
CD-ROM appears, click the [Exit] button to exit the screen.

3. Select “PC Camera” in the camera’s USB setting.

• Refer to “PC Connection” in the Owner’s Manual for your camera for more
information on camera operation and the USB setting.

• It is strongly recommended that you connect the AC power adapter when you
are using a USB connection to avoid loss of power while you are using the
camera.

4. Using the enclosed USB cable, connect the camera (or the
cradle) to the USB port on your computer and then switch the
camera on.

5. A message appears in the “New Hardware” dialog box
indicating that “USB PC Camera” has been detected.
✽ See P.25, if you are using Windows Millennium Edition.
✽ See P.26, if you are using Windows 2000 Professional.

NOTE

NOTE

If you are asked for a disk labeled “FINEPIX” during installation, refer to
“Troubleshooting” (see P.54).

6. The “Add New Hardware Wizard” dialog appears. Click the
[Next >] button.

If the dialog box does not appear,
uninstall and then re-install the PC
Camera Driver. (See P.22, 49.)

7. Select “Search for the best driver for your device
(Recommended)” and click the [Next >] button.

8. When the next window opens, tick the “CD-ROM drive”
checkbox and then click the [Next >] button.
✽ If any checkboxes other than “CD-

ROM drive” are ticked, clear the
ticks so that “CD-ROM drive” is the
only checkbox ticked.

✽ The dialog shown may differ slightly on some types of PC.

NOTE

Windows 98/98SE
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9. Check that VC4CB104.INF
has been detected and then
click the [Next >] button.

The Windows 98 CD-ROM may also be
required during installation. In this
event, switch CD-ROMs as directed by
the on-screen instructions.

10. When driver installation is
completed, the dialog shown
at right is appears. Click the
[Finish] button.

11. FinePixViewer starts up and the “PictureHello” window
automatically opens. Check that the live video image is
displayed in the “PictureHello” window.
✽ If live images are not displayed, installation was not completed successfully.

Refer to “Troubleshooting” (P.59).

NOTE

6. The “Add New Hardware Wizard” dialog opens. Click the
[Next >] button.

• It may take a few minutes for the
dialog box shown at right to appear
after USB PC Camera is detected.

• If the dialog box does not appear,
uninstall and then re-install the PC
Camera Driver. (See P.22, 49.)

• The Windows Me CD-ROM may also
be required during installation. In this
event, switch CD-ROMs as directed by
the on-screen instructions.

7. When driver installation is
completed, the screen
shown at right appears. Click
the [Finish] button.

8. FinePixViewer starts up and the “PictureHello” window
automatically opens. Check that the live video image is
displayed in the “PictureHello” window.
✽ If live images are not displayed, installation was not completed successfully.

Refer to “Troubleshooting” (P.59).

NOTE

Windows Millennium Edition (Windows Me)
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9. Check that VC4CB104.INF
has been detected and then
click the [Next >] button.

10. When the “Digital Signature
Not Found” message
appears, click the [Yes]
button.

The Windows 2000 Professional CD-
ROM may also be required during
installation. In this event, switch CD-
ROMs as directed by the on-screen
instructions.

11. When driver installation is
completed, the screen
shown at right appears.
Click the [Finish] button.

12. FinePixViewer starts up and the “PictureHello” window
automatically opens. Check that the live video image is
displayed in the “PictureHello” window.
✽ If live images are not displayed, installation was not completed successfully.

Refer to “Troubleshooting” (P.59).

NOTE

6. The “Found New Hardware
Wizard” dialog opens. Click
the [Next >] button.

If the dialog box does not appear,
uninstall and then re-install the PC
Camera Driver. (See P.22, 49.)

7. Select “Search for a suitable
driver for my device
(recommended)” and then
click the [Next >] button.

8. In “Optional search locations”, tick the “CD-ROM drives”
checkbox and then click the [Next >] button.
✽ If any checkboxes other than “CD-

ROM drives” are ticked, clear the
ticks so that “CD-ROM drives” is the
only checkbox ticked.

✽ The screen shown may differ slightly depending on the type of computer.

NOTE

Windows 2000 Professional



For detailed information on using the FinePixViewer and DP Editor, refer to
“English.pdf” in “FinePixViewer” in “Programs” in the “Start” menu.

• Do not perform the operations listed below when a camera (removable disk) file
is open and the camera display indicates that data access is in progress.
Performing any of these operations could corrupt the data on the SmartMedia
or damage the SmartMedia itself.
Switch the camera off/Touch any of the camera control buttons/
Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia
cover/Remove the camera batteries/Remove the camera from the cradle

• Do not use your computer to format the SmartMedia in the camera as this may
make the card unusable for taking pictures.

1. Start up your PC and double-
click the “My Computer” icon.
✽ If you are running Windows 2000

Professional, log on using the user
account you normally use.

2. Select the camera settings.
If your camera has “DSC (Mass Storage)” and “PC Camera” functions in the USB setting 
(such as FinePix6800 ZOOM)

Load a SmartMedia containing images you have shot into the
camera. Select “DSC” in the camera’s USB setting.

If your camera has only the “DSC (Mass Storage)” function in the USB setting 

Load a SmartMedia containing images you have shot into the
camera.

• It is strongly recommended that you connect the AC power adapter when you
are using a USB connection to avoid loss of power while you are using the
camera.

• Refer to “PC Connection” in the Owner’s Manual for your camera for more
information on camera operation and the USB setting.

• Use only SmartMedia containing images shot on a FUJIFILM digital camera.

NOTE

NOTE

TIP
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• When you install Exif Launcher, it is registered in the startup menu and is
launched automatically when Windows starts up.

• If the icon in the figure is shown in the
taskbar, Exif Launcher is running.

• To quit Exif Launcher, click the right mouse button on the [ ] icon in the
taskbar and select “Exit” from the menu that appears. 

� When you quit Exif Launcher, the icon will disappear from the taskbar.

Connecting the Camera and PC and Viewing Images

Using the Software on Windows

To View Images Using FinePixViewer

Thumbnail display area

<FinePixViewer startup window>

Thumbnail images for the image data 
recorded on the SmartMedia are 
displayed in the thumbnail display area.

This thumbnail indicates 
an audio file.

Folder tree display area

Thumbnail

3. Using the enclosed USB cable, connect the camera (or the
cradle) to the USB port on your computer and then switch the
camera on.
� When the “Removable Drive” icon

appears in the “My Computer”
window, the camera and PC are
correctly connected.

✽ The window actually shown on your
PC may differ from that shown in the
figure.

4. Launch FinePixViewer.

If you are running Exif Launcher

When you connect the camera (or the cradle) to the USB port
on your PC, Exif Launcher starts up FinePixViewer.
✽ If you have altered the Exif Launcher settings, FinePixViewer will not start up.

If you are not running Exif Launcher

Select “Programs” / “FinePixViewer” / “FinePixViewer” in
the “Start” menu. FinePixViewer then starts up.

If FinePixViewer is slow to start up, refer to “Troubleshooting” (P.56).

NOTE

Exif Launcher

Have the Owner’s Manual for your camera handy and read it
in conjunction with these instructions.
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1. To exit FinePixViewer, select “Exit” from the “File” menu or
click the [Close] button in the main window.

2. Check that the camera display indicates that data access is
no longer in progress.
On Windows 2000 Professional and Windows Me, click the
eject icon [ ] on the taskbar when the camera display
indicates that data access is no longer in progress and
remove “USB Mass Storage” or “USB Disk”.

3. Switch the camera off and then disconnect it.

• You must first close all the camera (removable disk) files and check that the
camera access indicator is no longer lit.

• When the “Copying” message disappears from your PC screen, wait a few
moments before removing the camera from the cradle, disconnecting the USB
cable or removing the SmartMedia.
If a large amount of data is being copied, camera access continues for a short
time after the message displayed on the PC has gone off.

• Refer to the Owner’s Manual for your camera for more information on the
access display on the camera.

• In Windows 2000 Professional or Windows Me, your PC may malfunction if you
remove the camera from the cradle or disconnect the USB cable without first
using the “Eject hardware” procedure.

NOTE

To Disconnect the Camera
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The camera is connected as a removable disk drive. The images on the
SmartMedia are stored in folders (such as the “100_FUJI” folder), in the
“DCIM” folder on the removable disk drive.

1. Drag the “100_FUJI” folder from
the folder tree display area and
drop it into the “My Documents”
folder.
� Copying begins.

2. When copying is completed,
double-click “My Documents” to
open the folder and then click the
“100_FUJI” folder inside “My
Documents”.

3. Click the “100_FUJI” folder again
and rename it.

Including the date in the name can make it easier to identify the folder later.

• Do not rename folders on the SmartMedia as this could make it impossible to
play back the images on the camera.

• If there is already a folder with the
same name in the “My Documents”
folder, a message appears saying,
“The folder with the same name as
“XXXXXX” already exists. Overwrite?”.
If this occurs, click the [Rename]
button and rename the folder before
copying.

NOTE

TIP

Saving images on your PC

1. When you click the folder you copied to the folder tree
display area, thumbnail versions of the images in the folder
are displayed.

2. If you then double-click one of the thumbnail images, the
image appears in its own image window.
Click the [ ] (Close) button in the top-right corner of the
window to close the image window.

Checking saved images on your PC



� Attaching Images

1. Launch FinePixViewer.
In the “Start” menu, select “Programs” / “FinePixViewer” /
“FinePixViewer”.

2. Click the folder containing
the images you want to
attach.

3. Click the thumbnails for the
images to select them.
✽ Up to 10 images can be sent with

one e-mail message.

4. With the images selected, click
“Mail Sending” in the “File” menu.
✽ You can send a total of up to 1 MB of image

data at one time. 
If the total exceeds 1 MB, a warning
message appears when you click “Mail
Sending”. If this occurs, reduce the number
or size of the images until the message no
longer appears.

5. The Outlook Express or
Outlook2000 mail transmission
window opens and the images are
automatically attached to your e-
mail message. Type in the
address, title and your message
and then send the message in the
usual way.

Do not quit FinePixViewer until mail transmission is complete, as this will prevent
the e-mail with the images attached from being sent.

NOTE
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Attaching Images to E-mail Messages in FinePixViewer
FinePixViewer provides a simple procedure for attaching images to an e-mail
message.
✽ This feature can only be used when Outlook Express or Outlook2000 is selected as

your default e-mail application.

Contact your ISP (Internet Service Provider) for information on setting up
Outlook Express or Outlook2000.

� Check the following:
Check that Outlook Express or Outlook2000 is registered as your default 
e-mail application.

1. Click “Control Panel” /
“Internet Properties” and
then click “Programs”.

2. Check that Outlook Express
or Outlook2000 is shown in
the “E-mail” field.

Follow the procedure below to set up Outlook Express to attach images to e-mail
messages in FinePixViewer✽. To check the Outlook Express version, click “About
Microsoft Outlook Express” in the Outlook Express “Help” menu.
✽This feature can be used only when Outlook Express is selected as your default

e-mail application.
1 Quit any e-mail applications other than Outlook Express 4 that are currently

running.
2 Click “Options” in the “Tools” menu to open the “Options” window.
3 Click the “General” tab and click the “Make Outlook Express my default e-mail

program” checkbox so that it is ticked.
4 Click the “Make Outlook Express my default Simple MAPI client” checkbox so

that it is ticked. When the confirmation message for the changed settings
appears, click [Yes].

5 Click [OK] to close the “Options” window and click [OK] again when the following
message appears:

“The Simple MAPI client has been changed. You may need to restart your
machine for this change to take effect.”

6 Exit Outlook Express and restart your computer.

When Using Outlook Express 4 on Windows 98
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To use the FinePix Internet services, users must first register.
✽ Follow the steps below to register. Users can be registered for free.

1. Select “Programs” / “FinePixViewer” / “FinePixViewer” in
the “Start” menu to launch FinePixViewer.

2. Click the “User’s
Registration” button. The
operation selection dialog
box appears.

<User’s Registration button>

3. Select “User’s registration” and click the [OK] button.
� If you are not already connected to

the Internet, connect at this point. 
(A dial-up dialog box may be
displayed.)

✽ Only select menu acquisition if you
have already completed the user
registration process and you have
re-installed “FinePixViewer”, etc.

User Registration

Using the FinePix Internet Service
If you use the FinePixViewer, you can also access the FinePix Internet
Service via the Internet.
When you register, you will be able to use the various services provided in the
country where you are registered.
• The services provided vary depending on the country.
• The services are frequently updated, so we recommend that you access

them regularly.
• In order to access the service you need to have an internet connection,

provided by an ISP (Internet Service Provider.)
✽ You must have the hardware and software required for connecting to the Internet.
✽ The FinePix Internet Service does not include any connection fees charged by your

service provider or the normal telephone charges for dialing your service provider’s
access number.

34

� Setting the file size for attached images
When FinePixViewer attaches an image file to an e-mail message, it adjusts
the size of the image file in accordance with the “Mail Transmission Settings”.
The file size is preset to an appropriate size for e-mailing immediately
following installation, but this setting can also be revised.
✽ When an image is resized, the original image is not affected.

1. Click “Mail Transmission Settings” in the “Settings” menu.

2. Place a tick in the “Resize”
checkbox and specify the
number of pixels (height and
width) for resized images.

3. Place a tick in the “File Format Conversion” checkbox and
select the format (compression ratio) for converted files.

To prevent image resizing, remove the tick from the “Resize” and “File Format
Conversion” checkboxes.

TIP
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Once user registration is completed, you can use the FinePix Internet
services.

� Selecting services

1. Click the menu button for the service you want to use.
� If you are not already connected to the Internet, the software automatically

attempts to connect (for dial-up connections).
� Operation after you click the menu button differs depending on the button you

click. For instance, you may jump to your service provider’s web site or an
upload dialog box may open.

✽ The actual Internet menu may differ slightly in appearance from the sample
shown here.

Move the mouse cursor over an Internet menu button to view information about
the service.

2. When you have finished using the Internet services,
disconnect from the Internet (for dial-up connections).

The connection speed will vary significantly depending on the quality of your
phone line and the amount of traffic on the server to which you are connected.

� Updating the Menu

1. Select “Menu Update” from the “View” menu.

2. The User Verification dialog box appears.
Enter the user ID and password set during user registration
and then click the [OK] button to update the Internet menu.

� If you are not already connected to the Internet, the software automatically
attempts to connect (for dial-up connections).

As well as the Internet menu being updated, related information pages may also
be opened. Because these pages may contain good news or useful information,
you should update the Internet menu frequently.

TIP

NOTE

TIP

Using the Services4. The User’s Registration dialog box
opens. 
Select the country or area where
you are living and click the [OK]
button.
The browser starts up and opens
the user registration page. Use this
page to register as a user.
✽ After you register, a confirmation e-mail message is sent to you. Be sure to enter

a valid e-mail address at which you can receive the message.
✽ The actual user registration page may differ slightly in appearance from the

sample shown here.
✽ If the country or area where you are living does not appear in the pull-down list,

select “OTHERS”. A button linking to the English home page for FUJI PHOTO
FILM CO. LTD. (TOKYO, JAPAN) will be displayed.

� Viruses
A virus infecting your PC can result in the loss of important data or the
sending of unwanted e-mail messages to the people stored in your
address book. Do not open downloaded files or files received as e-mail
attachments unless you are certain of their content.

� Private Information
If you send a message to the other party during a videoconference, the
message is not encoded. Take care not to send important information
such as telephone or credit card numbers.

Important Information for Internet Users
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� PictureHello Nomenclature

Other party’s image

Right-click pop-up menu

Your image

9

Portrait images are inset composite images.

Name Explanation

q Connection icon Indicates whether you are logged in to the server.

w Login button Logs in to the server.

e Logout button Logs out from the server.

r Start Call button Notifies the other party that the call has begun.

t End Call button Ends a call.

y Close button Exits PictureHello.

u Address Book button Opens the address book.

i Address input field Used for specifying the party to be called. You can use
this field to directly type in the other party's e-mail
address.

o Capture button Pauses the video image of the other party and saves
the paused frame as a still image.

!0 Remote party information Reflects the information in the address book.

!1 Own information E-mail address used at user registration.

!2 Message to other party Message entered during login.

!3 Answer automatically Tick this checkbox to begin videoconferencing 
checkbox automatically.

!4 Bandwidth (network speed) Select the network connection speed used for calls
from this list. If you change the bandwidth, you must
then restart FinePixViewer.

!5 “Pause” If you uncheck this item, the live image on your screen
begins to move. When you want to check whether the
live image is displayed correctly, uncheck this item.
(“Pause” is unchecked automatically during calls.)

!6 Items other than PictureHello automatically selects the optimum setting.
“Pause” and “Copy” Ordinarily, these settings can be ignored.

✽ Menu displayed when
you click the right
mouse button on your
image.

Videoconferencing Using PictureHello
� What is videoconferencing?
Videoconferencing is a form of communication in which you can see a live
image of the person you are calling as you converse in realtime. This
explanation describes the use of the FinePixViewer PictureHello software, in
which specific PCs communicate with each other (one-to-one communication)
via the Internet.

� Hardware and software required for videoconferencing
� A FUJIFILM camera equipped with the “PC Camera” function
� A PC with an Internet connection

✩ 56kbps modem connection or better or an ISDN connection
✩ An established service contract with an Internet service provider (ISP)
✽ Depending on your type of Internet connection and/or your modem connection

speed, video quality may deteriorate and some frames may be lost.
✩ A sound card installed and speakers and a microphone connected to your PC
✽ PCs that do not have a sound card installed and speakers and a microphone

connected can only be used to transmit images.
✽ For the best results, use headphones with an attached microphone.
✩ If your Internet connection is via a router or via a LAN (connecting machines on

the LAN to the Internet), you cannot use videoconferencing.
� FinePixViewer and NetMeeting 3.01 installed
� A completed FinePix Internet Service user registration

✽ When the user registration button [ ] is displayed on the right side of the
FinePixViewer window, you must complete the user registration procedure. 
(See P.35.)

Take care when using your own e-mail address. Disclosing your e-mail address to
people other than those you wish to call could result in unintentional and
unnecessary videoconferencing calls from third parties.

Important Notes on E-mail Addresses for Videoconferencing
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� Starting the call

1. Click the [ ] (Address
Book) button to open the
Address Book.

2. Click the Update Status button in the Address Book to check
the status of the party you are calling.

If the other party is available

Click the information column for the other party to select him
or her and then click the Start Call button.
� The call begins when the other party replies.

If the other party is unavailable

1 Stay logged on and wait a few minutes.
2 Click the Update Status button in the Address Book to

check the status of the other party.
3 Repeat steps 1 and 2 until the other party becomes

available. If you decide not to call, see “Ending the
Videoconference” on P.42.

� When a call comes in
A confirmation dialog box appears. click the [Yes] button to
begin the call.

� If you click the [No] button, the call
does not begin. The caller sees a
message stating, “The other party
cannot receive calls.”

If you tick the “Automatically accept incoming calls” checkbox, no confirmation
message is displayed and the call begins automatically.

� Saving a Caller’s Image
1. When you click the [ ] (Capture) button during a call, the

“Remote party information” image is updated.

TIP

� Preparations for videoconferencing (to be followed by both parties)
1. Exchange e-mail address (the address used at FinePix

Internet Service user registration) and store the other party’s
e-mail address in your PictureHello address book (see P.43).

2. Select “PC Camera” in the camera’s USB settings. Use the
special USB cable to connect the camera to the USB port on
your PC and then switch the camera on. Check that
FinePixViewer has started up and the “PictureHello” window
has opened automatically.
� To open the PictureHello window manually, select “Open Window” from the

“Videoconference” menu in FinePixViewer.
✽ If a video input device other than the camera is connected to your PC,

disconnect the video input device and then reconnect the camera.
✽ You cannot use PictureHello and NetMeeting concurrently. If you are using

PictureHello, do not launch NetMeeting.
✽ Refer to “PC Connection” in the Owner’s Manual for your camera for more

information on camera operation and the USB settings.

• Do not switch off the camera or disconnect the USB cable during live image
display as this may cause your PC to hang.

• It is strongly recommended that you connect the AC power adapter during
videoconferencing to prevent the camera from switching off.

• If the “PictureHello” window does not open, check the following:
1. Is “PC Camera” selected in the USB settings on the camera?
2. Is the USB cable connected correctly?
If the problem is not caused by either of these, refer to “Troubleshooting” (P.59).

• If no live image is displayed, right-click in the live image display area and
uncheck “Pause” in the menu (see P.39).

3. Log in.

If your system is set up to automatically connect to the Internet

Click the [ ] (Login) button.

If your system is set up for manual connection to the Internet

Connect to the Internet and then click the [ ] (Login) button.

4. A message input dialog box opens. Type in a message to the
other party and click the [OK] button.
� When you are successfully logged in,

the [ ] connection icon changes
to indicate a call in progress.

• Messages are sent without being encoded. Do not include sensitive information
in your message.

• To change the message, you must log out and then log in again.

NOTE

NOTE
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You can use the address book to check the status of other parties and to store
addresses. To view the address book, click the [ ] (Address Book) button.

� Checking the status
Click the Update Status button to check the latest status details.

Update Status button

Click the [ ](Capture) button to
store or update.

1Other party’s name
2Other party’s E-mail address
3Comment (not seen by the other party)
4Message written when the other party

logged in

Status

1

2

3

4

Icon Can be called? Status of other party

No Not logged in.

Yes Logged in.

No Logged in but busy with another call.

Unclear Unclear. Click the Update Status button.

� Storing addresses
To add a new address or edit an existing address, click the [New] or [Edit]
button. Enter or modify each item and then click the [OK] button.

1Other party’s name
2Other party’s E-mail address
3Comment (not seen by the other party)

1

2

3

2. A dialog box to confirm the save destination appears. When
you select “Paste to address book” and click the [OK] button,
the image in the address book is updated.
✽ If you accept a call, you can only

select “Copy to Clipboard” during the
call.

� Ending a Call
Click the [ ] (End Call) button.

If you call someone who is not already listed in the Address Book, a dialog box
appears when the call ends asking you whether you would like to store the other
party’s details in the Address Book. Click the [Yes] button to store the
information in the Address Book.

� Ending the Videoconference
1. When you click the [ ] (Logout) button, the connection to

the server is ended.

2. To exit PictureHello, click the [ ] (Close) button.

If you are using a dial-up connection, logging out does not disconnect you from
the Internet. If you have finished using the Internet, disconnect manually.

NOTE

TIP

Using the Address Book
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Using VideoImpression
You can use VideoImpression to make your own movies.
For more information on VideoImpression, refer to the contact information
provided on the back cover of this manual.

• Allows you to create and save movies that include both still and moving
images and sound.

• Allows you to edit your movies so you can cut unwanted scenes or add
captions.

• Provides effective ways of switching from one scene to another (transitions).
✽ More information on these functions and how to use them is available as follows:

• Open the “English.pdf” file in the “Manual” folder inside “Vimpress” on the
enclosed CD-ROM.

• Check on the Internet by clicking the link in the bottom right corner of the screen.
• Use the contact details printed on the back cover to contact FUJIFILM.

Main Functions

� Store the movie in an album
To work with still images, video and sound, you first have to import them into
the album window.

1. In the “Start” menu, select “Programs” / “ArcSoft
VideoImpression” / “ArcSoft VideoImpression 1.6” to launch
VideoImpression.

2. Click the [new] button to open an album window.

3. Drag the thumbnails from FinePixViewer and drop them into
the album window.

Making Your Own Movies

<FinePixViewer>

Customizing the Camera
Cameras with a customization function can be customized using special
customization software downloaded from the FinePix Internet Service.

1. Download the special customization software from the
FinePix Internet Service or from the following web site and
install it in the “DSCSETUP” folder in the “FinePixViewer”
folder on your PC.

http://home.fujifilm.com/products/digital/

2. When you click the “camera customization” button on the
FinePixViewer, the customization software starts up and the
settings dialog box appears.
✽ Refer to the downloading web page for information on installing the

customization software.
✽ Refer to “PC Connection” in the Owner’s Manual for your camera for more

information on transferring data from your PC to the camera.
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Capturing Live Images

If you are using a camera with the “PC Camera” function in the USB settings,
you can import live images from the camera.
✽ It is strongly recommended that you connect the AC power adapter when you are

using a USB connection to avoid loss of power while you are using the camera.
✽ Refer to “PC Connection” in the Owner’s Manual for your camera for more information

on camera operation and the USB settings.

1. Select “PC Camera” in the camera’s USB settings.

2. Using the special USB cable, connect the camera (cradle) to
the USB port on your computer and then switch the camera
on. If you have launched FinePixViewer, exit the program.

3. In the “Start” menu, select “Programs” / “ArcSoft
VideoImpression” / “ArcSoft VideoImpression 1.6”.

4. When the startup screen appears,
click the [new] button.

5. When the album window opens,
click the [capture] button.

3. When you click the [save] button, the Save dialog box
appears. Specify the save location, file name, etc. and save
the movie file.

• If you leave the mouse pointer positioned over a button or image for a few
seconds, information about that button or image is displayed.

• In any window, you can access the online help by clicking “?”.
• In addition to “MPEG”, you can choose from a wide range of formats for saved

files.

TIP

� Add a storyboard
In the storyboard, you select the files to be used in the movie and set the
order in which the files are played.

1. Add files to the movie by dragging
them from the album window and
dropping them onto the
storyboard.

2. If necessary, you can drag items
around in the storyboard to
change the playback sequence.

� Add text
1. Click the [edit movie] button to

switch to the editing window.

2. Click the [text] button and enter the text.
� You can use the drag handle to adjust the position.

3. Use the buttons below the image to specify settings such as
the typeface and the time for which the text appears.

� Play back and save the movie
1. Click the [play movie] button to

switch to the playback window.

2. Click the Play button and check
the movie.

Drop images into here.

Drop sounds [ ] into here.
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Uninstalling Software from a Windows PC
Uninstalling the Driver

� Uninstall the USB Driver in the following situations:
• When you have installed Mass Storage Driver but the camera still does not

appear as a removable disk icon
• When you want to remove an unwanted driver
• When you are upgrading the driver
• When you have installed the driver but it does not work. (Uninstall the driver

and then re-install it.)

• Disconnect the camera beforehand.
• Close all files when removing drivers.

1. Switch on your PC and launch Windows.

2. Insert the enclosed CD-ROM into the CD-ROM drive.
If the installation screen for the applications provided on the
CD-ROM appears, click the [Exit] button to exit the screen.

3. Launch the Uninstaller.
For Mass Storage Driver

Open “My Computer”, right-click the CD-ROM icon and select
“Open” to display the contents of the CD-ROM. Double-click
“UNIN_MAS.EXE” to remove the installed driver.

For PC Camera Driver

Open “My Computer”, right-click the CD-ROM icon and select
“Open” to display the contents of the CD-ROM. Double-click
“UNIN_PCC.EXE” to remove the installed driver.
✽ The way file names are displayed differs as described below depending on your

computer settings.
• File extensions (3-letter suffixes indicating the file type) may be shown or

hidden.
• Text may be shown normally or all in uppercase (e.g. Setup or SETUP).

4. Reboot your PC to complete the uninstallation process.

NOTE

6. Display switches to the capture window and the live image is
displayed. If the live image does not appear, click the Live
button 1.
✽ Recording has not yet started.

7. Use the Drives button 2 to select “USB PC Camera”.

8. Click the Record button 3 to start recording.

9. Click the Record button again 3 to end recording.
✽ The recorded images are not saved to a file.

� To check the images

Click the Play button 4.

� To save the images to a file and return to the Album window
1. When you click the [album] button, the Save dialog box opens. Specify the

save destination and click the [OK] button.
2. When the album storage confirmation dialog box appears, click the [OK]

button.

• You must have a sound card installed and speakers and a microphone
connected to your PC to input and output sound.

• The time required for playing and saving images varies depending on the
performance of your PC.

• Do not perform any of the following while live camera images are being
displayed as this could cause your PC to freeze (see P.62):
Switch off the camera/Touch any of the control buttons on the camera/
Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia
cover/ Remove the camera battery/Remove the camera from the cradle.

NOTE

1 3 4

2
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Troubleshooting
If the software does not operate correctly but the problem does not match any
of those listed below, check that you are using the correct hardware and
software. (See P.10.)
If the problem persists even though you are using the correct hardware and
software, refer to the table below and then see the reference page listed for
your problem.

Page
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with

The camera is connected to my PC but the Mass Storage Driver installation
will not start.

The camera is connected to my PC but the PC Camera Driver installation will
not start.

I was asked for a disk labeled “FINEPIX” during Mass Storage Driver
installation.

I was asked for a disk labeled “FINEPIX” during PC Camera Driver installation.

I was asked for the “WINDOWS” CD-ROM during Mass Storage Driver/PC
Camera Driver installation.

When I connect the camera to my PC, the “Add New Hardware Wizard”
appears.

When I double-click the removable disk icon, “The device is not ready” error
message appears.

A warning message appeared when I removed the SmartMedia from the
camera.

“Device disconnection warning” appears when I disconnect the special USB
cable.

When I disconnect the special USB cable and double-click the removable disk
icon, a message appears and the window does not open.

FinePixViewer automatic startup is slow.

I want to stop the FinePixViewer from launching automatically.

The camera and PC are connected but no removable disk icon is displayed.

The PC hangs when I access the SmartMedia.

The PictureHello (videoconferencing) window does not open.

PictureHello (videoconferencing) does not show video of me.

I clicked the Login button in PictureHello (videoconferencing), but I can’t log in.

The live image of the other party in videoconferencing is very jerky.

There is no live image of the other party during videoconferencing.

Videoconferencing call notifications are not displayed.

I can make calls but I cannot use videoconferencing.

I can’t hear the other party in the videoconference/The other party can’t hear me.

Live images do not appear in the VideoImpression Capture window.

I can’t log in to the “FinePix Internet Service”.

I can’t sign on as a “FinePix Internet Service” user.

My PC does not shut down correctly.

My camera will no longer play back image files.

I can’t play AVI files on Windows Media Player.

I can’t update the Internet menu properly. (The buttons do not line up correctly.)

Uninstalling FinePixViewer, DP Editor and Exif Launcher

You can automatically uninstall these application programs using
“Add/Remove Programs” in the Control Panel.

• Use this procedure only when the installed software is no longer required or
when software installation fails.

• Always quit FinePixViewer, DP Editor and Exif Launcher before beginning
uninstallation. For information on shutting down Exif Launcher, refer to the
lower half of P.29.

• Uninstall Exif Launcher before uninstalling FinePixViewer.
Connecting the camera to your PC with only Exif Launcher left installed could
cause problems.

1. Switch on your PC and start up Windows.

2. Open the “My Computer” window and double-click
“Add/Remove Programs” in the Control Panel.

3. Select the application to be uninstalled.
The “Add/Remove Programs Properties” window appears.
Select the program to be deleted (FinePixViewer, Exif
Launcher or DP Editor) and click the [Add/Remove] button.

4. Confirm the deletion. 
A confirmation dialog box appears. Uninstallation cannot be
cancelled once it has been confirmed in this dialog box.
Check the details carefully.

5. UninstallShield starts up.
When uninstallation ends, click the [OK] button.

NOTE
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Possible cause Solution

� The camera is connected to my PC but the PC Camera Driver
installation will not start.

Is the camera (cradle) switched on?

Is “PC Camera” selected as the
camera’s USB setting?

Is the special USB cable connected to
the camera (cradle) and to the
computer?

Are you using a compatible operating
system?

If you are using Windows 2000
Professional, are you logged on as an
Administrator group?

Is “PC Camera Driver” not listed under
“Other Devices” in the Device
Manager?

Are the USB functions active?
Double-click “System” in the Control
Panel, select “Device Manager” and
check “Universal Serial Bus
controllers”.

Is an older version of the PC Camera
Driver installed?

Switch the camera on. If you are using the
cradle, connect the AC power adapter to
the cradle and press the [<] button. Refer
to the Owner’s Manual for your camera for
details.

Change the camera’s USB setting to “PC
Camera”. Refer to “PC Connection” in the
Owner’s Manual for your camera for details.

Check that one end of the special USB
cable is connected to the camera (cradle)
and the other end is connected to the
computer.

The PC Camera Driver should be used
with Windows 98/98SE, Windows Me or
Windows 2000 Professional.

Log on as an Administrator group.
Refer to the User’s Manual for your PC for
more information on Administrators.

The driver is not installed correctly.
Uninstall (see P.49) and then re-install
driver.

• If “Universal Serial Bus controllers” is not
displayed, the USB functions is disabled.
Refer to the User’s Manuals supplied
with your PC for details of how to enable
the USB functions.

• USB functions are disabled when the
item is marked with a yellow exclamation
mark “!” or red cross “x”. Refer to the
User’s Manuals supplied with your PC
for details of how to enable the USB
functions.

Use the CD-ROM provided to uninstall
any older versions of the PC Camera
Driver. Then install the new PC Camera
Driver provided on the CD-ROM.

Possible cause Solution

� The camera is connected to my PC but the Mass Storage Driver
installation will not start.

Is the camera (cradle) switched on?

Is “DSC” selected as the camera’s USB
setting?

Is the special USB cable connected to
the camera (cradle) and to the
computer?

Are you using a compatible operating
system?

If you are using Windows 2000
Professional, are you logged on as an
Administrator group?

Is “USB Mass Storage” not listed under
“Other Devices” in the Device
Manager?

Are the USB functions active?
Double-click “System” in the Control
Panel, select “Device Manager” and
check “Universal Serial Bus
controllers”.

Is an older version of the Mass Storage
Driver installed?

Switch the camera on. If you are using the
cradle, connect the AC power adapter to
the cradle and press the [<] button. Refer
to the Owner’s Manual for your camera for
details.

Change the camera’s USB setting to
“DSC”. Refer to “PC Connection” in the
Owner’s Manual for your camera for details.

Check that one end of the special USB cable
is connected to the camera (cradle) and the
other end is connected to the computer.

The Mass Storage Driver should be used
with Windows 98/98SE, Windows Me or
Windows 2000 Professional.

Log on as an Administrator group.
Refer to the User’s Manual for your PC for
more information on Administrators.

The driver is not installed correctly.
Uninstall (see P.49) and then re-install
driver.

• If “Universal Serial Bus controllers” is not
displayed, the USB functions is disabled.
Refer to the User’s Manuals supplied
with your PC for details of how to enable
the USB functions.

• USB functions are disabled when the
item is marked with a yellow exclamation
mark “!” or red cross “x”. Refer to the
User’s Manuals supplied with your PC
for details of how to enable the USB
functions.

Use the CD-ROM provided to uninstall
any older versions of the Mass Storage
Driver. Then install the new Mass Storage
Driver provided on the CD-ROM.

Troubleshooting Installation Problems
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Possible cause Solution

� When I connect the camera to my PC, the “Add New Hardware Wizard”
appears.

Is the USB Driver installed? Use the enclosed CD-ROM to install the
driver. (See P.16, 22.)

Possible cause Solution

� When I double-click the removable disk icon, “The device is not
ready” error message appears.

Is the SmartMedia loaded in the
camera?

Load a SmartMedia into the camera.
Refer to the Owner’s Manual for your
camera for details.

Possible cause Solution

� A warning message appeared when I removed the SmartMedia from
the camera.

Did you eject the SmartMedia while
data access to the camera was still in
progress?

This action can damage the SmartMedia
and destroy data on the SmartMedia.
Always close all the files on the camera
(the removable disk) and wait until the
camera display indicates that data access
is no longer in progress before removing
the SmartMedia.

Possible cause Solution

� “Device disconnection warning” appears when I disconnect the
special USB cable.

Are you using Windows 2000
Professional or Windows Me?

Before disconnecting the special USB
cable, click the “ (Eject)” icon in the
Taskbar and disconnect the camera.

Troubleshooting Connection and Image Viewing Problems
Solution

� I was asked for a disk labeled “FINEPIX” during Mass Storage Driver
installation.

1Click the [Browse] button in the “Copy files” dialog box.
2In the dialog box that then appears, select the CD-ROM icon in the drive display

area, refer to the information in the table below and specify the appropriate folder
and then click the [OK] button.

3In the “Copy files” dialog box, click the [OK] button to install the driver. Then click
the [Finish] button.

OS Type Name of Folder 
Windows 98 D:\
Windows Me D:\Usbdrv\Winme
Windows 2000 Professional D:\

� I was asked for a disk labeled “FINEPIX” during PC Camera Driver
installation.

OS Type Name of Folder
Windows 98 D:\win98
Windows Me D:\win9x
Windows 2000 Professional D:\i386

✽ When using CD-ROM Drive D

✽ When using CD-ROM Drive D

If no Windows CD-ROM was supplied with your PC, contact your PC manufacturer.

NOTE

� I was asked for the “WINDOWS” CD-ROM during Mass Storage Driver/
PC Camera Driver installation.

Solution

1Click the [Browse] button in the “Copy files” dialog box.
2In the dialog box that then appears, select the CD-ROM icon in the drive display

area and then click the [OK] button.
3In the “Copy files” dialog box, click the [OK] button to install the driver. Then click

the [Finish] button.

Solution

1Load the Windows CD-ROM into the CD-ROM drive.
2Click the [Browse] button in the “Copy files” dialog box.
3In the dialog box that then appears, select the CD-ROM icon in the drive display

area, refer to the information in the table below and specify the appropriate folder
and then click the [OK] button.

4In the “Copy files” dialog box, click the [OK] button to install the driver. Then click
the [Finish] button.
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Possible cause Solution

� The camera and PC are connected but no removable disk icon is
displayed.

Is the camera (cradle) switched on?

Is the SmartMedia loaded in the
camera?

Is “DSC” selected as the camera’s USB
setting?

Is the special USB cable connected to
the camera (cradle) and to the
computer?

Are you using a compatible operating
system?

Is the Mass Storage Driver running?

If you are using Windows 2000
Professional, are you logged on as an
Administrator group?

Switch the camera on. If you are using the
cradle, connect the AC power adapter to
the cradle and press the [<] button. Refer
to the Owner’s Manual for your camera for
details.

Load a SmartMedia into the camera.
Refer to the Owner’s Manual for your
camera for details.

Change the camera’s USB setting to
“DSC”. Refer to “PC Connection” in the
Owner’s Manual for your camera for
details.

Check that one end of the special USB
cable is connected to the camera (cradle)
and the other end is connected to the
computer.

The Mass Storage Driver should be used
with Windows 98/98SE, Windows Me or
Windows 2000 Professional.

Double-click “System” in the Control
Panel, select the Device Manager tab and
check the Mass Storage Driver. If the
driver is marked with a yellow “!” or a red
“x”, Mass Storage Driver is not running.
Uninstall and then re-install Mass Storage
Driver (see P.16, 49).

Log on as an Administrator group.
Refer to the User’s Manual for your PC for
more information on Administrators.

Possible cause Solution

� FinePixViewer automatic startup is slow.

Are you running too many background
applications?

Click the “Start” button and select
“Programs” / “Startup” from the Start
menu. Click the right mouse button on any
shortcuts for infrequently used
applications from the “Startup” window.
Click “Delete” from the pop-up menu and
then restart your PC.

Solution

� I want to stop the FinePixViewer from launching automatically.

Either of the two methods below can be used to prevent FinePixViewer from launching
automatically.

• Change the Exif Launcher settings.
1Click the right mouse button on the Exif Launcher icon in the taskbar and select

“Settings” from the pop-up menu.
2Uncheck the “Automatic startup - Media insertion” checkbox.
✽ To restore the original setting, use the same procedure to re-tick the checkbox.

• Remove Exif Launcher.
1Click the right mouse button on the Exif Launcher icon in the taskbar and click

“Quit” from the pop-up menu.
2Click the “Start” button and select “Programs” / “Startup” / “Exif Launcher” from

the Start menu. Right-click the “Exif Launcher” icon and click “Remove” from the
pop-up menu.

✽ To restore Exif Launcher, create an Exif Launcher shortcut in the “Startup” window.

Possible cause Solution

� When I disconnect the special USB cable and double-click the
removable disk icon, a message appears and the window does not open.

Is another USB removable drive
connected?

Some USB removable drives do not
operate correctly if other USB removable
drives are being used at the same time.
Disconnect all the connected USB
removable drives and then connect the
camera.
However, with some USB storage devices,
computer operation may become unstable
when the Exit Launcher is resident. See “I
want to stop the FinePixViewer from
launching automatically” (below) and try
removing the Exit Launcher.
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Possible cause Solution

� The PictureHello (videoconferencing) window does not open.

Are FinePixViewer and NetMeeting 3.01
installed?

Is FinePixViewer running?

Is the camera (cradle) switched on?

Is “PC Camera” selected as the USB
setting on the camera?

Is the special USB cable connected to
the camera (cradle) and PC?

Are you using a compatible operating
system?

Is the PC Camera Driver running?

Install FinePixViewer and NetMeeting
3.01 from the enclosed CD-ROM. 
(See P.13.)

In the “Start” menu, select “Programs” /
“FinePixViewer” and click “FinePixViewer”.

Switch the camera on. If you are using the
cradle, connect the AC power adapter to
the cradle and press the [<] button. Refer
to the Owner’s Manual for your camera for
details.

Change the camera’s USB setting to “PC
Camera”. Refer to “PC Connection” in the
Owner’s Manual for your camera for
details.

Check that one end of the special USB
cable is connected to the camera (cradle)
and the other end is connected to your PC.

Use Windows 98, Windows 98SE,
Windows Me or Windows 2000
Professional.

Double-click “System” in the Control
Panel, select the Device Manager and
check “USB PC Camera” in “Imaging” or
“Other Devices”. If “USB PC Camera” is
marked with a yellow exclamation mark “!”
or a red cross “x”, it is not running.
Uninstall and then re-install PC Camera
Driver (see P.22, 49).

Possible cause Solution

� PictureHello (videoconferencing) does not show video of me.

Is another video input device
connected to your PC?

Is another application displaying the
live images from the camera?

Did you disconnect the special USB
cable or switch off the camera (cradle)
during live image display?

Disconnect all other video input devices.

Quit any other application that is
displaying live images.

Quit PictureHello and then restart your
PC. Check that the special USB cable is
connected correctly to the camera and
your PC and then switch the camera
(cradle) on.

Troubleshooting Videoconferencing ProblemsPossible cause Solution

� The PC hangs when I access the SmartMedia.

When opening the Device Manager,
there is a yellow “!” mark next to the
driver in “Universal Serial Bus
controllers”.

When opening the Device Manager,
there is a yellow “!” mark next to Mass
Storage Driver.

Is an older version of the Mass Storage
Driver software installed?

You are using a driver or camera that
prevents the driver for the Universal Serial
Bus controllers from operating. Refer to
the User’s Manual for your PC and check
your hardware and software setup.

You are using a driver or camera that
prevents the Mass Storage Driver from
operating. Uninstall and then re-install
Mass Storage Driver (see P.16, 49).

Use the CD-ROM provided to uninstall
any older versions of the Mass Storage
Driver. Then install the new Mass Storage
Driver provided on the CD-ROM.
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Possible cause Solution

� I can make calls but I cannot use videoconferencing.

Is the other party able to make or
accept calls?

Are you or the other party trying to call
outside from an in-house LAN?

Are you or the other party trying to call
outside from a home-office LAN?

Open the address book and click the
Update Status button. If the other party
cannot accept calls, try again later. 
(See P.41.)

Calls cannot be made in either direction
between a LAN and an external line. Use
a dial-up connection.

Calls cannot be made in either direction
between a LAN and an external line. Use
a dial-up connection.

Possible cause Solution

� I can’t hear the other party in the videoconference/The other party
can’t hear me.

Are the speakers set to playback
mode?

Is the microphone operating normally?

You and the other party should use the
following procedure to check the speaker
setup:
1Check that the speakers are

connected correctly to your PC.
2In the “Start” menu, select “Programs”
/ “Accessories” / “Entertainment”
and click “Volume Control”. Then
adjust the volume.

You and the other party should use the
following procedure to check the
microphone setup:
1Check that the microphone is

connected correctly to your PC.
2In the “Start” menu, select “Programs”
/ “Accessories” / “Entertainment”
and click “Sound Recorder”. Then
adjust the microphone input level.

Possible cause Solution

� I clicked the Login button in PictureHello (videoconferencing), but I
can’t log in.

Are you able to connect to the
Internet?

Is the FinePix Internet Service
undergoing maintenance?

Have you completed the user
registration process?

Check your PC hardware and software
setup.

Log in after the maintenance is
completed.

Sign on as a FinePix Internet Service
user. (See P.35.)

Solution

� The live image of the other party in videoconferencing is very jerky.

Use a high-speed line with a connection speed of 56 kbps or better.

Possible cause Solution

� There is no live image of the other party during videoconferencing.

Are you or the other party trying to call
outside from an in-house LAN?

Are you or the other party trying to call
outside from a home-office LAN?

Calls cannot be made in either direction
between a LAN and an external line. Use
a dial-up connection.

Calls cannot be made in either direction
between a LAN and an external line. Use
a dial-up connection.

Possible cause Solution

� Videoconferencing call notifications are not displayed.

Is the “Automatically accept incoming
calls” checkbox ticked?

Are you logged in to the server?

Uncheck the “Automatically accept
incoming calls” checkbox.

Log in to the server.
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Possible cause Solution

� I can’t log in to the “FinePix Internet Service”.

Are you able to connect to the
Internet?

Is the FinePix Internet Service
undergoing maintenance?

Have you completed the user
registration process?

Check your PC hardware and software
setup.

Log in after the maintenance is
completed.

Click the FinePixViewer user registration
button and sign on as a FinePix Internet
Service user. (See P.35.)

Possible cause Solution

� I can’t sign on as a “FinePix Internet Service” user.

Have you already signed on under the
same e-mail address?

You cannot sign on twice with the same
user ID or e-mail address.

Possible cause Solution

� My camera will no longer play back image files.

Did you rename any files or folders
inside the DCIM folder?

Did you replace an image file inside the
DCIM folder?

Change the file or folder names in the
DCIM folder back to the original names.

Do not replace image files in the DCIM
folder.

Solution

� My PC does not shut down correctly.

Disconnect the PC and the camera using the correct procedure and then exit
Windows.

Solution

� I can’t play AVI files on Windows Media Player.

If you want to use Windows Media Player, you must install DirectX 8.0. See the
Microsoft homepage or industry-related magazines for information on how to acquire
DirectX 8.0.

Solution

� I can’t update the Internet menu properly. (The buttons do not line up
correctly.)

The menu data is corrupted. Use the procedure below to update the menu:
1Quit FinePixViewer.
2From the “Start” menu, select “FinePixViewer” in “Programs”. Then right-click on

the “FinePixViewer” icon in the “FinePixViewer” folder and select “Properties”.
3Click the “Find link destination” button to display the folder in which FinePixViewer

was installed.
4Delete the “FinePixInternetFiles” folder in the FinePixViewer installation folder.
5Launch FinePixViewer and click the “Update” button.

� Some types of PC may not shut down correctly while the camera is still connected.

Possible cause Solution

� Live images do not appear in the VideoImpression Capture window.

Do you have Windows Media Player
installed?

Is the camera (cradle) switched on?

Is “PC Camera” selected as the USB
setting on the camera?

Is the special USB cable connected to
the camera (cradle) and PC?

Are you using a compatible operating
system?

Is the PC Camera Driver running?

Is another video input device selected?

Is another application displaying the
live images?

Did you disconnect the special USB
cable or switch off the camera (cradle)
during live image display?

Install Windows Media Player from the
enclosed CD-ROM. (See P.13.)

Switch the camera on. If you are using the
cradle, connect the AC power adapter to
the cradle and press the [<] button. Refer
to the Owner’s Manual for your camera for
details.

Change the camera’s USB setting to “PC
Camera”. Refer to “PC Connection” in the
Owner’s Manual for your camera for
details.

Check that one end of the special USB
cable is connected to the camera (cradle)
and the other end is connected to your PC.

Use Windows 98, Windows 98SE,
Windows Me or Windows 2000
Professional.

Double-click “System” in the Control
Panel, select the Device Manager and
check “USB PC Camera” in “Imaging” or
“Other Devices”. If “USB PC Camera” is
marked with a yellow exclamation mark “!”
or a red cross “x”, it is not running.
Uninstall and then re-install PC Camera
Driver (see P.22, 49).

Select “USB PC Camera”. Refer to the
VideoImpression User’s Guide for
information on how to select the video
input device.

Quit any other application that is
displaying live images.

Quit VideoImpression and then restart
your PC. Check that the special USB
cable is connected correctly to the camera
and your PC and then switch the camera
(cradle) on.

Troubleshooting Other Problems
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1. Switch on your Macintosh and start up Mac OS.

2. Check whether File Exchange is active.
To use a SmartMedia that is supported by the camera, the File Exchange utility
supplied with Mac OS must be running. Select the Extensions Manager in the
Control Panels and check that the File Exchange check box is ticked. If not, click in
the box so that an [X] appears and then restart your Macintosh.

Installing the Software

Before You Install the Software

� The following applications and USB driver are installed by the
Installer:
USB driver
FinePixViewer
DP Editor
Exif Launcher
VideoImpression™
QuickTime™
Acrobat® Reader™

✽ When you install the USB driver, the following files are installed in the
“Extensions” folder:
“USB04CB_StorageShim”, “USB04CB_StorageDriver”, “USB04CB_VcShim”
and “USB04CB_VcDriver”

Pre-installation Checklist

Installation on a Macintosh

� Hardware and software requirements
To run this software, you must have the hardware and software described
below. Check your system before you begin the installation.

Compatible Mac : Power Macintosh G3✽1, PowerBook G3✽1, 
Power Macintosh G4, iMac, iBook, 
Power Macintosh G4 Cube, or PowerBook G4

Operating System : Mac OS 8.6 to 9.1
RAM : 64 MB minimum✽2

Display : 800 × 600 pixels or better, at least 32,000 colors
Hard disk space : Amount required for installation: 70 MB minimum

Amount required for operation: 300 MB minimum
Supported cameras : Fujifilm digital cameras equipped with a USB interface
Internet connection✽3: 56 kbps modem connection (recommended) or better

or an ISDN connection
Sound functions✽4 : Speakers, microphone and sound card

✽1 Models with a USB port as a standard feature
✽2 Turn virtual memory on if necessary.
✽3 Required to use the FinePix Internet Service. The software can still be installed

even if you do not have an Internet connection.
✽4 Sound functions are required for audio input/output in VideoImpression.

• Connect the camera/cradle directly to the Macintosh using the special USB
cable. The software may not operate correctly if you use an extension cable or
connect the camera/cradle via a USB hub.

• Push the USB connector fully into the socket to ensure that it is securely
connected. The software may not operate correctly if the connection is faulty.

• Additional USB interface board is not guaranteed.
• Use the drivers (the Mass Storage Driver and PC Camera Driver) provided on

the enclosed CD-ROM. When older drivers are already installed on your PC,
uninstall the old versions and then re-install the drivers provided on the
enclosed CD-ROM.

• This software is not compatible with Mac OS X.

NOTE
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� Selecting the installation destination
1 Click the [Open] button to open the

installation destination folder.

2 To install the software in the
displayed folder, click the [Save]
button.

6. Use the same procedure to install “Acrobat Reader”.
✽ To read the FinePixViewer User’s Guide (PDF), you must have Acrobat Reader

from Adobe Systems, Inc. installed.

1. When you load the enclosed CD-ROM into the CD-ROM drive,
the “FinePix” window automatically opens and the “Installer”
appears.

If the “FinePix” window does not open
automatically, double-click the CD-ROM icon.

2. Double-click “Installer” to launch the Installer.

3. The Installer setup screen
appears.
Click the [Install
FinePixViewer] button.

4. A list of the applications to be installed appears. Check the
list and then click the [OK] button.

5. Proceed with the installation as directed by the on-screen
instructions.
✽ See “Selecting the installation destination” on the next page for information on

how to specify the installation destination.

NOTE

Installation Procedure

• When the “User Registration” window opens during installation, you can complete
the installation without entering any data.

• If the “Connection speed” window appears, set the correct speed for your type of
connection and proceed with the installation.

Notes on Installing QuickTime
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Connecting the Camera and Macintosh and Viewing Images

Using the Software on a Macintosh

For detailed information on how to use the FinePixViewer and DP Editor software, refer
to “English.pdf” in the folder in which FinePixViewer and DP Editor were installed.

• Do not perform any of the following operations during camera access as this
could result in damage to the data on the SmartMedia or damage to the
SmartMedia itself.
Switch the camera off/Touch any of the camera control buttons/
Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia cover/
Remove the camera batteries/Remove the camera from the cradle

• Do not use your computer to format the SmartMedia in the camera as this may
make the card unusable for taking pictures.

• If you use a SmartMedia that was formatted on the camera and replace a folder
on the SmartMedia with a folder with the same name on your hard disk, the files
may be corrupted. Delete the folder on the SmartMedia or rename the folder
before copying it to the SmartMedia.

1. Start up your Macintosh.

2. Select the camera settings.
If your camera has “DSC (Mass Storage)” and “PC Camera” functions in the USB setting 
(such as FinePix6800 ZOOM)

Load a SmartMedia containing images you have shot into the
camera. Select “DSC” in the camera’s USB setting.

If your camera has only the “DSC (Mass Storage)” function in the USB setting 

Load a SmartMedia containing images you have shot into the
camera.

• It is strongly recommended that you connect the AC power adapter when you
are using a USB connection to avoid loss of power while you are using the
camera.

• Use only SmartMedia containing images shot on a FUJIFILM digital camera.

3. Using the enclosed USB cable, connect the
camera (or the cradle) to the USB port on your
computer and then switch the camera on.
� If a removable disk icon appears on the desktop, the

camera and Macintosh are correctly connected.

NOTE

NOTE

TIP

To View Images Using FinePixViewer

The User’s Guide (PDF) and How to Read It
To read the FinePixViewer User’s Guide (PDF), you must have Adobe
Systems’ Acrobat Reader installed on your computer. See P.67 for
information on installing Acrobat Reader.

� Reading the User’s Guide

1. Double-click “English.pdf” in the folder in which
FinePixViewer was installed.
� Acrobat Reader starts up and displays the User’s Guide.

2. To jump to the relevant page, click the desired topic listed in
the Contents or Bookmarks.
✽ To view the bookmarks, click “Show Bookmarks” in the Window menu.

For more information on how to use Acrobat Reader, refer to the Online Guide in
the Acrobat Reader Help menu.

� Printing the User’s Guide

1. Click “Page Setup” in the File menu and specify the required
settings (“Paper”, “Layout”, etc.).
� If you print the manual at the original dimensions, each page fits on one sheet

of A4 paper in Portrait layout.

2. Click the [Print] button or select “Print” in the File menu.

3. Specify the range of pages to be printed and the number of
copies, etc. and then click the [OK] button.

• The available options vary depending on your printer and printer driver
software. Refer to your printer driver manual for details.

• For more information, refer to the Online Guide in the Acrobat Reader Help
menu.

NOTE

Have the Owner’s Manual for your camera handy and read it
in conjunction with these instructions.



71

Macintosh

70

1. To exit FinePixViewer, select “Quit” from the “File” menu or
click the Close box in the main window.

2. Drag the “Removable disk” icon on the desktop to the Trash.
Alternatively, select the icon and then select “Eject” from the
Special menu in the menu bar along the top of the screen.

3. When a message appears indicating that it is OK to remove
the card or cable from the camera, disconnect the camera.

Switching off the camera or removing the SmartMedia without using the eject
procedure described above could damage the SmartMedia or cause your
Macintosh to malfunction.

NOTE

To Disconnect the Camera

When you double-click a thumbnail, the image is displayed in a new image
window.
To close the image window, click the Close box in the top-left corner of the
window.
You can copy an image and save it to the hard disk of your PC by dragging its
thumbnail and dropping it onto the desktop or into a folder.

Thumbnail display area

<FinePixViewer startup window>

Thumbnail images for the image data 
recorded on the SmartMedia are 
displayed in the thumbnail display area.

This thumbnail indicates 
an audio file.

Thumbnail

Folder tree display area

Attaching Images to E-mail Messages in FinePixViewer
FinePixViewer provides a simple procedure for attaching images to an e-mail
message.
✽ This feature can only be used when Outlook Express is selected as your default 

e-mail application.

Contact your ISP (Internet Service Provider) for information on setting up
Outlook Express.

� Check the following:
Check that Outlook Express is registered as your default e-mail application.

1. Click “Control Panels” /
“Internet” and then click the
“E-mail” tab.

2. Check that “Outlook
Express” is shown in
“Default E-mail Application”.

� Attaching Images

1. Launch FinePixViewer.
Double-click “FinePixViewer” in the folder in which you
installed FinePixViewer.

2. Click the folder containing
the images you want to
attach.

3. Click the thumbnails for the
images to select them.
✽ Up to 10 images can be sent with

one e-mail message.

4. Launch FinePixViewer.

If you are running Exif Launcher

When you connect the camera (or the cradle) to the USB port
on your PC, Exif Launcher starts up FinePixViewer.
✽ If you changed the Exif Launcher settings, FinePixViewer will not start up.

If you are not running Exif Launcher

Double-click the FinePixViewer icon in the installed folder.

• Exif Launcher starts up automatically when you start up your Macintosh.
• To quit Exif Launcher, select “Exif Launcher Settings” in the “Settings” menu in

FinePixViewer and then select “Quit Exif Launcher immediately”.

Exif Launcher
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To use the FinePix Internet services, users must first register.
✽ Follow the steps below to register. Users can be registered for free.

1. Double-click the FinePixViewer icon in the installed folder.

2. Click the “User’s
Registration” button. The
operation selection dialog
box appears.

<User’s Registration button>

3. Select “User’s registration” and click the [OK] button.
� If you are not already connected to

the Internet, connect at this point. 
(A dial-up dialog box may be
displayed.)

✽ Only select menu acquisition if you
have already completed the user
registration process and you have
re-installed “FinePixViewer”, etc.

User Registration

Using the FinePix Internet Service
If you use the FinePixViewer, you can also access the FinePix Internet
Service via the Internet.
When you register, you will be able to use the various services provided in the
country where you are registered.
• The services provided vary depending on the country.
• The services are frequently updated, so we recommend that you access

them regularly.
• In order to access the service you need to have an internet connection,

provided by an ISP (Internet Service Provider.)
✽ You must have the hardware and software required for connecting to the Internet.
✽ The FinePix Internet Service does not include any connection fees charged by your

service provider or the normal telephone charges for dialing your service provider’s
access number.

4. With the images selected, click
“Mail Sending” in the “File” menu.
✽ You can send a total of up to 1 MB of image

data at one time. If the total exceeds 1 MB, a
warning message appears when you click
“Mail Sending”. If this occurs, reduce the
number or size of the images until the
message no longer appears.

5. The Outlook Express mail
transmission window opens and
the images are automatically
attached to your e-mail message.
Type in the address, title and your
message and then send the
message in the usual way.

Do not quit FinePixViewer until mail transmission is complete, as this will prevent
the e-mail with the images attached from being sent.

� Setting the file size for attached images
When FinePixViewer attaches an image file to an e-mail message, it adjusts
the size of the image file in accordance with the “Mail Transmission Settings”.
The file size is preset to an appropriate size for e-mailing immediately
following installation, but this setting can also be revised.
✽ When an image is resized, the original image is not affected.

1. Click “Mail Transmission Settings” in the “Settings” menu.

2. Place a tick in the “Resize”
checkbox and specify the
number of pixels (height and
width) for resized images.

3. Place a tick in the “File Format Conversion” checkbox and
select the format (compression ratio) for converted files.

To prevent image resizing, remove the tick from the “Resize” and “File Format
Conversion” checkboxes.

TIP

NOTE
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Once user registration is completed, you can use the FinePix Internet
services.

� Selecting services

1. Click the menu button for the service you want to use.
� If you are not already connected to the Internet, the software automatically

attempts to connect (for dial-up connections).
� Operation after you click the menu button differs depending on the button you

click. For instance, you may jump to your service provider’s web site or an
upload dialog box may open.

✽ The actual Internet menu may differ slightly in appearance from the sample
shown here.

Move the mouse cursor over an Internet menu button to view information about
the service.

2. When you have finished using the Internet services,
disconnect from the Internet (for dial-up connections).

The connection speed will vary significantly depending on the quality of your
phone line and the amount of traffic on the server to which you are connected.

� Updating the Menu

1. Select “Menu Update” from the “View” menu.

2. The User Verification dialog box appears.
Enter the user ID and password set during user registration
and then click the [OK] button to update the Internet menu.

� If you are not already connected to the Internet, the software automatically
attempts to connect (for dial-up connections).

As well as the Internet menu being updated, related information pages may also
be opened. Because these pages may contain good news or useful information,
you should update the Internet menu frequently.

TIP

NOTE

TIP

Using the Services4. The User’s Registration dialog box
opens. 
Select the country or area where
you are living and click the [OK]
button.
The browser starts up and opens
the user registration page. Use this
page to register as a user.

✽ After you register, a confirmation e-mail message is sent to you. Be sure to enter
a valid e-mail address at which you can receive the message.

✽ The actual user registration page may differ slightly in appearance from the
sample shown here.

✽ If the country or area where you are living does not appear in the pull-down list,
select “OTHERS”. A button linking to the English home page for FUJI PHOTO
FILM CO. LTD. (TOKYO, JAPAN) will be displayed.

Viruses
A virus infecting your PC can result in the loss of important data or the
sending of unwanted e-mail messages to the people stored in your
address book. Do not open downloaded files or files received as e-mail
attachments unless you are certain of their content.

Important Information for Internet Users
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Using VideoImpression
You can use VideoImpression to make your own movies.
For more information on VideoImpression, refer to the contact information
provided on the back cover of this manual.

• Allows you to create and save movies that include both still and moving
images and sound.

• Allows you to edit your movies so you can cut unwanted scenes or add
captions.

• Provides effective ways of switching from one scene to another (transitions).
✽ More information on these functions and how to use them is available as follows:

• Open the “English.pdf” file in the “Manual” folder inside “Vimpress” on the
enclosed CD-ROM.

• Check on the Internet by clicking the link in the bottom right corner of the screen.
• Use the contact details printed on the back cover to contact FUJIFILM.

Main Functions

� Store the movie in an album
To work with still images, video and sound, you first have to import them into
the album window.

1. Double-click the VideoImpression in the folder in which
VideoImpression was installed to launch VideoImpression.

2. Click the [new] button to open an album window.

3. Drag the thumbnails from FinePixViewer and drop them into
the album window.

Making Your Own Movies

<FinePixViewer>

Customizing the Camera
Cameras with a customization function can be customized using special
customization software downloaded from the FinePix Internet Service.

1. Download the special customization software from the
FinePix Internet Service or from the following web site and
install it in the “DSCSETUP” folder in the “FinePixViewer”
folder on your Macintosh computer.

http://home.fujifilm.com/products/digital/

2. When you click the “camera customization” button on the
FinePixViewer, the customization software starts up and the
settings dialog box appears.
✽ Refer to the downloading web page for information on installing the

customization software.
✽ Refer to “PC Connection” in the Owner’s Manual for your camera for more

information on transferring data from your PC to the camera.
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Capturing Live Images

If you are using a camera with the “PC Camera” function in the USB settings,
you can import live images from the camera.
✽ It is strongly recommended that you connect the AC power adapter when you are

using a USB connection to avoid loss of power while you are using the camera.
✽ Refer to “PC Connection” in the Owner’s Manual for your camera for more information

on camera operation and the USB settings.

1. Select “PC Camera” in the camera’s USB settings.

2. Using the special USB cable, connect the camera (cradle) to
the USB port on your computer and then switch the camera
on. If you have launched FinePixViewer, exit the program.

3. Double-click the VideoImpression icon in the folder in which
VideoImpression was installed.

4. When the startup screen appears,
click the [new] button.

5. When the album window opens,
click the [capture] button.

• If you leave the mouse pointer positioned over a button or image for a few
seconds, information about that button or image is displayed.

• In any window, you can access the online help by clicking “?”.
• In addition to “MPEG”, you can choose from a wide range of formats for saved

files.

TIP� Add a storyboard
In the storyboard, you select the files to be used in the movie and set the
order in which the files are played.

1. Add files to the movie by dragging
them from the album window and
dropping them onto the
storyboard.

2. If necessary, you can drag items
around in the storyboard to
change the playback sequence.

� Add text

1. Click the [edit movie] button to
switch to the editing window.

2. Click the [text] button and enter the text.
� You can use the drag handle to adjust the position.

3. Use the buttons below the image to specify settings such as
the typeface and the time for which the text appears.

� Play back the movie

1. Click the [play movie] button to
switch to the playback window.

2. Click the Play button and check
the movie.

Drop images into here.

Drop sounds [ ] into here.
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Uninstalling the Software on a Macintosh

Use this procedure only when the installed software is no longer required or
when software installation fails.

NOTE

Uninstalling Mass Storage Driver and PC Camera Driver

First, check that the digital camera is no longer connected. Then
open the Extensions folder on the hard disk and move the
following four files to the Trash:
“USB04CB_StorageShim”
“USB04CB_StorageDriver”
“USB04CB_VcShim”
“USB04CB_VcDriver”

Then, restart your Macintosh and select “Empty Trash” from the
Special menu.

1. After you have quit Exif Launcher in “Exif Launcher Settings”
in the FinePixViewer “Settings” menu, move the Exif
Launcher file from the “Startup Items” folder in the System
folder to the Trash. Then select “Empty Trash” in the
“Special” menu.

2. Quit FinePixViewer and DP Editor and move the
FinePixViewer and DP Editor files to the Trash. Then select
“Empty Trash” from the Special menu.

Uninstalling Exif Launcher, FinePixViewer and DP Editor

6. The Capture window appears and the live image is displayed.
✽ Recording has not yet started.

7. Click the [Capture Video] button to begin recording the
movie.
� The name of the button changes to [Stop Capture]. During recording, only the

[Stop Capture] button can be pressed.

8. Click the [Stop Capture] button to stop recording. The movie
data will be automatically saved to a file and imported to the
Album.

9. Click the [Done] button to return to the Album window.

• You must have a sound card installed and speakers and a microphone
connected to your PC to input and output sound.

• The time required for playing and saving images varies depending on the
performance of your PC.

• Do not perform any of the following while live camera images are being
displayed as this could cause your PC to freeze (see P.85):
Switch off the camera/Touch any of the control buttons on the camera/
Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia
cover/ Remove the camera battery/Remove the camera from the cradle.

NOTE

<Standby> <Movie recording in progress>
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Possible cause Solution

� The camera and PC are connected but no removable disk icon is displayed.

Is the camera (cradle) switched on?

Is the SmartMedia loaded in the
camera?

Is “DSC” selected as the camera’s USB
setting?

Is the special USB cable connected to
the camera (cradle) and to the
computer?

Are you using a compatible operating
system?

Is the Mass Storage Driver active?

Switch the camera on. If you are using the
cradle, connect the AC power adapter to
the cradle and press the [<] button. Refer
to the Owner’s Manual for your camera for
details.

Load a SmartMedia into the camera.
Refer to the Owner’s Manual for your
camera for details.

Change the camera’s USB setting to
“DSC”. Refer to “PC Connection” in the
Owner’s Manual for your camera for details.

Check that one end of the special USB
cable is connected to the camera (cradle)
and the other end is connected to the
computer.

The USB Driver should be used with Mac
OS 8.6 to 9.1. (It is not compatible with
Mac OS X.)

Enable “USB04CB_StorageShim” and
“USB04CB_StorageDriver” in the
Extensions Manager and restart your
Macintosh.

Possible cause Solution

� The PC hangs when I access the SmartMedia.

Is the software installed? Install the software on your PC.

Possible cause Solution

� A warning message appears when I remove the SmartMedia or
disconnect the USB cable from the camera.

Did you eject the SmartMedia or
disconnect the USB cable while the
camera was still mounted as a disk
drive?

This action can damage the SmartMedia
and destroy data on the SmartMedia.
Before ejecting the SmartMedia or
disconnecting the USB cable, always
select the drive and then choose “Eject”
from the “Special” menu. Alternatively,
you can drag the drive icon to the Trash.

� When I connected the camera to my PC, the “Required software not
found” message or “Required driver cannot be used” message
appears.

Troubleshooting
If the software does not operate correctly but the problem does not match any
of those listed below, check that you are using the correct hardware and
software. (See P.64.)
If the problem persists even though you are using the correct hardware and
software, refer to the table below and then see the reference page listed for
your problem.

Troubleshooting Connection and Image Viewing Problems

Possible cause Solution

Is the software installed? Install the software on your PC.

Page
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When I connected the camera to my PC, the “Required software not found”
message or “Required driver cannot be used” message appears.

When I connected the USB cable, Mac OS displayed the “Initialize disk?” message.

The PC hangs when I access the SmartMedia.

The camera and PC are connected but no removable disk icon is displayed.

A warning message appears when I remove the SmartMedia or disconnect
the USB cable from the camera.

I can’t log in to the “FinePix Internet Service”.

I can’t sign on as a ”FinePix Internet Service” user.

I can’t update the Internet menu properly. (The buttons do not line up correctly.)

The FinePixViewer Upload dialog box does not appear.

The “Process aborted because error occurred during communication.”
message appears while you are using the FinePixViewer Upload dialog box.

Live images do not appear in the VideoImpression Capture window.

My camera will no longer play back image files.

I want to stop the FinePixViewer from launching automatically.

� When I connected the USB cable, Mac OS displayed the “Initialize
disk?” message.

Possible cause Solution

Is the SmartMedia formatted? Disconnect the USB cable from the camera,
insert the SmartMedia into the camera and
format the SmartMedia. Refer to the
Owner’s Manual for your camera for details.

Enable File Exchange. See P.65 for details.

Use a different SmartMedia.
� SmartMedia of this size are not recognized by File Exchange and cannot be used with a Mac OS.
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Possible cause Solution

� Live images do not appear in the VideoImpression Capture window.

Is the cradle (camera) switched on?

Is “PC Camera” selected as the
camera’s USB setting?

Is the special USB cable connected to
the camera (cradle) and to the
computer?
Are you using a compatible operating
system?

Is PC Camera Driver enabled?

Is another video input device selected?

Is another application displaying the
live images from the camera?
Did you disconnect the special USB
cable or switch off the camera (cradle)
during live image display?

Switch the camera on. If you are using the
cradle, connect the AC power adapter to the
cradle and press the [<] button. Refer to the
Owner’s Manual for your camera for details.

Change the camera’s USB setting to “PC
Camera”. Refer to “PC Connection” in the
Owner’s Manual for your camera for details.

Check that one end of the special USB cable
is connected to the camera (cradle) and the
other end is connected to the computer.

The USB Driver should be used with Mac
OS 8.6 to 9.1. (It is not compatible with
Mac OS X.)

Enable “USB04CB_VcShim” and
“USB04CB_VcDriver” in the Extensions
Manager and restart your Macintosh.

Select “USB PC Camera”. Refer to the
VideoImpression User’s Guide for information
on how to select the video input device.

Quit any other application that is
displaying live images.

Quit VideoImpression and then restart your
PC. Check that the special USB cable is
connected correctly to the camera and your
PC and then switch the camera (cradle) on.

Troubleshooting Other Problems

Possible cause Solution

� My camera will no longer play back image files.

Did you rename any files or folders
inside the DCIM folder?
Did you replace an image file inside the
DCIM folder?

Change the file or folder names in the
DCIM folder back to the original names.

Do not replace image files in the DCIM
folder.

Solution

� I want to stop the FinePixViewer from launching automatically.

You can use either of the two methods below to prevent FinePixViewer from launching
automatically.
• Change the Exif Launcher settings.
1Select “Exif Launcher Settings” in the FinePixViewer “Settings” menu and click “Do

not run Exif Launcher at restart.”
2Restart your computer.
✽ To restore the original setting, use the same procedure and tick the “Run Exif

Launcher at restart.” option.
• Remove Exif Launcher.
1Select “Exif Launcher Settings” in the FinePixViewer “Settings” menu and tick “Quit

Exif Launcher immediately”.
2Move “Exif Launcher” from the “Startup Items” folder in the System folder to the Trash.
3Select “Empty Trash” in the “Special” menu.
✽ To restore Exif Launcher, re-install the software.

Possible cause Solution

� I can’t sign on as a “FinePix Internet Service” user.

Have you already signed on under the
same e-mail address?

You cannot sign on twice with the same
user ID or e-mail address.

Possible cause Solution

� I can’t log in to the “FinePix Internet Service”.

Are you able to connect to the
Internet?

Is the FinePix Internet Service
undergoing maintenance?

Have you completed the user
registration process?

Check your PC hardware and software
setup.

Log in after the maintenance is
completed.

Click the FinePixViewer user registration
button and sign on as a FinePix Internet
Service user. (See P.73.)

Solution

� I can’t update the Internet menu properly. (The buttons do not line up
correctly.)

The menu data is corrupted. Use the procedure below to update the menu:
1Quit FinePixViewer.
2Double-click “System Folder” and then “Preferences” to open the Preferences

folder.
3Trash the “FinePixInternetFiles” folder in Preferences.
4Start up FinePixViewer and click the “Update” button.

Possible cause Solution

� The FinePixViewer Upload dialog box does not appear.

Do you have enough memory in your
system?

1Quit any other applications that are
running.

2Open “Memory” in “Control Panels” and
increase the amount of virtual memory
allocated. Then restart your Macintosh.

Solution

� The “Process aborted because error occurred during communication.”
message appears while you are using the FinePixViewer Upload dialog
box.

Use the following procedure to increase the allocated memory:
1Close the Upload dialog box and select the “Upload” file in the folder in which

FinePixViewer was installed.
2Select “Get Info” in the “File” menu. The “Upload Info” window opens.
3In “Memory”, increase the “Preferred Size” allocation.

Troubleshooting Internet Problems





Printed in Japan FGS-103103-FG

This brochure uses recycled paper.

North America and others
46601 Fremont Blvd.
Fremont, CA 94538
U.S.A.

Tel: +1-510-440-9901
Fax: +1-510-440-1270
Web site: www.arcsoft.com
E-Mail: support@arcsoft.com

Europe
Unit 14, Shannon Industrial Estate
Shannon, Co. Clare, Ireland

Tel: +353 (0) 61-702087
Fax: +353 (0) 61-702001
E-Mail: europe@arcsoft.com

Taiwan
ArcSoft Taiwan Representative Office
# 1, 5th Floor
164 North Fu Shin Road
Taipei, Taiwan

Tel: 886-2-2719-0225
Fax: 886-2-2719-0256

For inquiries regarding VideoImpression™

China
ArcSoft Beijing Representative Office
No 6 South Capital Gym Rd.
Beijing New Century Hotel, #1910
Beijing 100044, P.R. China

Tel: +86-10-6849-1368
Fax: +86-10-6849-1367
E-Mail: China@arcsoft.com

Australia
Marketing Results Prop Ltd.
P.O. Box 6246 BHBC
Baulkham Hills,
New South Wales 2153
Australia

Tel: +61 (2) 9899-5888
Fax: +61 (2) 9899-5728
E-Mail: david@mresults.ba.aust.com
Web site: www.marketingresults.com.au


